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Safety information
Important information

Read these instructions carefully and look at the equipment to become familiar
with the device before trying to install, operate, service or maintain it. The
following special messages may appear throughout this bulletin or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of either symbol to a "Danger" or "Warning" safety label
indicates that an electrical hazard exists which will result in personal
injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential
personal injury hazards. Obey all safety messages that follow this
symbol to avoid possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in
death or serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor
or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please Note

Electrical equipment should be installed, operated, serviced andmaintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training to
recognize and avoid the hazards involved.
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Safety precautions
Installation, wiring, testing and servicemust be performed in accordance with all local and
national electrical codes.

DANGER
ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical
work practices. In the USA, see NFPA 70E.

• Only qualified electrical workers should install this equipment. Such work should be
performed only after reading this entire set of instructions.

• NEVER work alone.
• Before performing visual inspections, tests, or maintenance on this equipment,
disconnect all sources of electric power. Assume that all circuits are live until they
have been completely de-energized, tested, and tagged. Pay particular attention to
the design of the power system.

• Consider all sources of power, including the possibility of backfeeding.
• Turn off all power supplying the powermeter and the equipment in which it is
installed before working on it.

• Always use a properly rated voltage sensing device to confirm that all power is off.
• Before closing all covers and doors, carefully inspect the work area for tools and
objects that may have been left inside the equipment.

• Use caution while removing or installing panels so that they do not extend into the
energized bus; avoid handling the panels, which could cause personal injury.

• The successful operation of this equipment depends upon proper handling,
installation, and operation. Neglecting fundamental installation requirements may
lead to personal injury as well as damage to electrical equipment or other property.

• NEVER bypass external fusing.
• The powermeter should be installed in a suitable electrical enclosure.

Failure to follow these instructions will result in death or serious injury.

© 2015Schneider Electric. All rights reserved. Page 5



WARNING
UNINTENDED EQUIPMENT OPERATION

• ION modules and registers must only be configured by personnel with a thorough
understanding of ION architecture and the system in which themeters and software
are installed.

• Do not usemeters or the software for critical control or protection applications where
human or equipment safety relies on the operation of the control circuit.

• Do not use an ION meter's digital output for any safety critical application due to
possible unexpected change of state during power cycles, power outages,
configuration changes or firmware upgrades.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the system, this can lead to inaccurate reports and/or
data results.

• Do not rely solely on reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Use reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

WARNING
INACCURATE DATA RESULTS

Do not install incorrect drivers for the circuit breakers in your system. This can lead to
algorithms not functioning correctly and to incomplete or inaccurate reports and/or data
results.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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NOTICE
UNINTENDED OPERATION

Make sure to enable the logs in the groups section when configuring the device.

Failure to enable the logs in the groups section will result in the inputs not
being available and not appearing in the Generator Performance Tool.
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Generator Performance
You can use theGenerator PerformanceModule tomonitor and analyze generator
performance. It consists of generator a utility that, when configured, can create reports to
help you determine how your generator is performing.

TheGenerator PerformanceGuide provides information on how to configure your generators
in PowerMonitoring Expert - Data Center Edition to create reports that you can use to
monitor and analyze your data center equipment. This guide also includes information on
how to configure PowerMonitoring Expert - Data Center Edition supportedmeters.

TheGenerator PerformanceModule consists of the following tools:

• "Generator Performance Configuration Tool" on page 63

After you use these tools to configure your system, you can generate the following reports:

• "Generator Activity Report" on page 77

• "Generator Load Summary Report" on page 99

• "Generator Battery Health Report" on page 92

• "Generator Battery Health Export" on page 96

• "Generator Test Report" on page 105

About this document
This guide provides information on how to configure PowerMonitoring Expert - Data Center
Edition tomanage and analyze the performance of your system's generators.

This manual is intended for Application Engineers, third-party integrators, and other qualified
personnel who are responsible for installing and integrating PowerMonitoring Expert - Data
Center Edition.

Refer to this manual along with the documentation sets PowerMonitoring Expert - Data
Center Edition. Where applicable, it will provide reference details when there is additional
information that can be found in these document sets.

Supporting documentation
Refer to the following documentation available with the installation files:

• PowerMonitoring Expert Installation Guide

• PowerMonitoring Expert Help

• PowerMonitoring Expert Data Center Edition Installation andMaintenanceGuide

• PowerMonitoring Expert Data Center Edition Design Guide

Generator PerformanceGuide Generator Performance
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ION Power Meter Configuration
This chapter describes how to complete the following tasks:

1. Add ION powermeters to PowerMonitoring Expert - Data Center Edition.
2. Deploy a custom framework on an ION powermeter using the Designer application of

PowerMonitoring Expert - Data Center Edition.

3. Configure the framework with site-specific information.

Experience using ION Setup, Designer, and other software is necessary to configure
ION powermeters. Successful completion of these tasks ensures that:

• The operational states on the generators are associated with the digital inputs on the ION
powermeters, and that the digital inputs are appropriately labeled and logged in the ION_
Data database.

• The engine data for the generators is associated with the analog inputs on the ION power
meters, and that the analog inputs are appropriately labeled and logged in the ION_Data
database.

• The electrical details for the generators are logged and saved in the ION_Data database.

WARNING
UNINTENDED OPERATION

• Do not use ION meters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Refer to the ION Reference for more information on ION module operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Supported ION Power Meters
PowerMonitoring Expert - Data Center Edition can use the following ION powermeters:

• PM8000, ION7550 and ION7650

• PM800 series powermeters

• PM8000 powermeters

Generator PerformanceGuide ION Power Meter Configuration
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Maintenance and Backups
As a good practice, always save a backup of the final framework that is pasted onto the
meter. Use Designer to create a copy of the framework from themeter. Save the framework
to a location from where the framework can be pasted back to themeter if necessary.

Be sure to save a backup of themeter's framework before deploying and configuring the
frameworks.

If a meter needs to be replaced, use the backup copy of the ION meter framework for the new
ION meter. For all other installation and configuration steps, youmust follow the original
commissioning steps as described in the following sections.

Refer to existing PowerMonitoring Expert documentation for instructions to backupmeter
frameworks.

Related Information
For information about adding ION powermeters to PowerMonitoring Expert - Data Center
Edition, see theManagement Console online help or theStruxureWarePowerMonitoring
Expert Help.

For details about configuring Analog or Digital Input modules, refer to ION Reference.

Prerequisites
The following items must be completed before attempting to configure ION powermeters to
record data from generators and other equipment.

• PowerMonitoring Expert - Data Center Editionmust be installed and operational.

• All ION powermeters must be installed and communicating.

• ION powermeters selected tomonitor each generator devicemust have the following
available data recorders and inputs:

• Two available data recorders

• Three available digital inputs (site specific)

• Two ormore available analog inputs (site specific)

See "Additional Information about Digital and Analog Inputs" on page 17
for more information.



WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the system, this can lead to inaccurate reports and/or data
results.

• Do not rely solely on reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Do not add any input to the Generator Data Recorder other than the input statuses
listed below.

• Use reports as a supplement to proper workplace practices or equipment maintenance,
not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

• Each generator should be physically wired to the appropriate ION powermeters so that
the following status signals are represented:

• Start (optional)

• Running

• Stopped

• The following generator electrical datamust bemetered and available for each generator:

• Vln a

• Vln b

• Vln c

• Vln avg

• Vll ab

• Vll bc

• Vll ca

• VII avg

• I a

• I b

• I c

• I avg

• kW tot

• kVA tot

• PF sign tot

• Freq

Additional Information about Digital and Analog Inputs

Digital Inputs
Meters used tomonitor generators and other equipment must have enough available digital
inputs to handle the incoming status signals. The number of required digital inputs depends
on how many signals are available and whether they are single state or dual state signals.

Example of single state signals, where signalA represents GEN Running

• When signalA = 1, GEN Running is TRUE

• When signalA = 0, GEN Running is FALSE

Example of dual state signals, where signalA represents GEN Running andGEN Stopped

• When signalA = 1, GEN Running is TRUE

• When signalA = 0, GEN Stopped is TRUE

Generator PerformanceGuide ION Power Meter Configuration
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Analog Inputs
Meters used tomonitor generators must have available analog inputs to handle the incoming
generator-specific analog data. The number of required analog inputs depends on how many
measurements are being recorded. For example, analog data can include the following:

• Exhaust Gas Temperature left and right

• Engine Coolant Temperature in and out

• Engine Oil Pressure

Generator analog signals can be obtained through the analog inputs or via Modbus Master
from the engine controller. Refer to thePowerLogic ION7550/7650 User Guide for more
information.

Add ION Devices to the System
Follow these steps to add ION powermeters to your system configuration.

Complete these steps to prevent any unwanted database actions whenmodifying the
meter framework. 

1. Stop the Log Inserter Service, as follows:

a. Open theWindows Services panel by clicking:

Start > Administrative Tools > Services

The path toServicesmay vary depending on theWindows operating
system being used.

b. Right-click ION Log Inserter Service and select Stop.

2. Open theManagement Console.

3. Use the Device window inManagement Console to add each ION powermeter.

The Device window includes Group andName fields. Group is the name under which
you want to associate the device you are adding. Name identifies themeter that you are
adding. Themeter name should include a reference to identify which ATS or generator is
connected to themeter.

When ameter has been added it appears in the list of devices in group.name format. For
example, if you named the group EPSS, and identified themeter as ATS1, the name in the
device list is EPSS.ATS1. Similarly, if you used the same group to add ameter identified
as GEN1, the name in the device list is EPSS.GEN1. See theStruxureWare Power
Monitoring Expert User Guide or online help for information about adding ameter.

After the powermeter is added, configure the appropriate frameworks as described in
"Deploying Generator Frameworks" on page 19.



Deploying Generator Frameworks

Overview
UseDesigner to copy and paste the generator framework to the powermeter. Repeat this
process for every powermeter in the system that records generator data for purposes. The
generator framework is designed to capture generator status changes when they occur, and
then to log generator-specific field data when the generator is active.

This framework is a template that should be adjusted tomeet the requirements of your site.
GEN Start or GEN Run can be used to initiate logging, and the frequency can be adjusted in
the periodic timer.

• The status signals for status events GEN Start, GEN Run, andGEN Stop are recorded in
the Gen State Log whenever any one of them changes state.

• The logic is designed to record analog and general electrical data when the generator is
running. The data is logged at oneminute intervals.

• The external BooleanGen Log Enmust be linked to a control object in a Vista diagram and
enabled before any data is logged. This allows users to notify the system that they are
running a test and to log data accordingly.

Pasting Generator Frameworks
Before you deploy generator frameworks, you need to be aware of the implications of free
pasting and lock pastingmodules.

Use free pasting to paste a new module with a different name if a module with the same
name already exists. This helps to ensure that existingmodules and their functionality are
not replaced.

Generator PerformanceGuide ION Power Meter Configuration
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Use lock pasting to overwrite an existingmodule and its functionality with a new module,
while retaining themodule name. However, you need to understand what themodules are
currently being used for before you lock paste themodules. A lock paste replaces the
functionality of thosemodules.

• If a powermeter already uses all modules of a certain type that are a necessary part of the
framework, then a lock paste operation is required.

• If all of the available digital or analog input modules are in use, a lock paste of the analog or
digital input modules is required to help ensure that the parameter settings are updated

Copy Generator Framework to ION Power Meter
UseDesigner to copy the generator framework to the powermeter. Repeat this process for
every powermeter in the system that records generator data.

1. InManagement Console click Tools > System > Designer. The Designer login window
appears.

2. Enter the login credentials with administrator or supervisor access and click OK.

3. Click File > Open, select the powermeter that has the generator connected to it, and then
click OK to open themeter’s framework.

4. Once themeter’s framework is open, navigate toAdvanced Setup and double-click the
Frameworks folder to open it.



5. Ensure that the Toolbox is open. Select Options > Show Toolbox, to open the Toolbox.

6. Select Edit > Paste from framework to open thePaste from frameworkwindow, from
which you paste the generator framework to the Frameworks – SPM Advanced
Configuration folder.

7. Navigate to ...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert DC
Ed\config\fmwk\EPSS , select the generator framework .fwn file, and click Open.

For example, in the following image the generator framework file is EPSS GEN.fwn.

Generator PerformanceGuide ION Power Meter Configuration
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8. Press Shift and left-click to lock paste all of the Analog Input and Digital Input modules
listed in thePaste Summary dialog, and free paste all of the remainingmodules.

The lock paste overwrites amodule if it already exists on themeter.

9. Do not selectMaintain external inputs.

10.Press OK to paste the generator framework.

Configure the Generator Framework
Configure the generator framework with site-specific data. Refer to the ION Reference for
more information about configuring setup registers.

1. After the generator framework has been pasted, double-click the folderEPSS GEN to
open its node diagram. 



The nodes of the generator framework shown below support the three single state status
signals: GEN Start, GEN Run, andGEN Stop. These status signals are received by their
respective digital input modules GEN Start, GEN Run, andGEN Stop.

The names of the digital input modules are simply placeholders that are used as examples
to identify how the components in the framework should be labeled. You can rename them
tomatch the system being deployed. For example, GEN could beGEN1. The remaining
descriptions in this section use these example labels to illustrate the updates made to the
framework.

The framework also supports three analog signals. In the following image, these are Ex
Gas L (exhaust gas left), Ex Gas R (exhaust gas right), and Coolant T (coolant
temperature), and these signals are received by their respective analog input modules: Ex
Gas L, Ex Gas R, and Coolant T. Thesemodule are examples only and they can be
modified to any other parameters that need to bemonitored and recorded.

A. Analog Input Modules B. Digital Input Modules

Generator PerformanceGuide ION Power Meter Configuration
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2. Right-click a Digital Input module to access its setup registers. The following image
shows the registers for the digital input module GEN Start. The generator controller
hardware that this module interfaces with governs how it needs to be configured.

3. To update a register, select the register and click Modify. TheModify Registers screen
appears.

4. Change the values to the site-specific sources and quantities, and click OK to return to
the node diagram. For example:

• The Setup Register Input Mode is set to KYZ, which forces a pulse output on both
leading and trailing edges of the signal. This causes the data recorder to record the state
on each transition of the signal.

• TheOutput Register label EPSS_Start is the name associated with the signal
received by the digital input module GEN Start. Themaximum number of characters for
the label is 15. Examples of Output Register labels for digital input modules GEN Run
andGEN Stop are EPSS_Run and EPSS_Stop, respectively.

Make sure that Output Register labels are consistent across the entire system. For
example, if you plan to represent the GEN Start state as EPSS_Start, then you need
to use the same label for all of the generators.

Make sure that Output Register labels are consistent across the entire system.
For example, if you plan to represent the GEN Normal state as EPSS_Norm,
then you need to use the same label for all of the generators.

For systems that use a single meter to record EPSS status measurements for
multiple EPSS devices, the Output Register naming convention for digital input
modules must bemodified from quantity to quantity@source. 



For example, change EPSS_Test to EPSS_Test@GENxx where xx uniquely
identifies the generator device.

The quantity@source format allows the data it represents to be uniquely
identified.

The quantities remain the same (EPSS_Test, EPSS_Emerg, EPSS_
Norm) but the source name is now unique (GENxx). If this change is not
made, data for all generators recorded on themeter cannot be uniquely
identified.

5. Right-click an Analog Input module to access its registers. Shown below are the registers
for the analog input module Ex Gas L. The generator controller hardware that this module
interfaces with governs how it needs to be configured.

• TheOutput Register label ExGasL is the name associated with the signal received by
the analog input module Ex Gas L. Themaximum number of characters for the label is
15. Examples of Output Register labels for analog input modules Ex Gas R and Coolant
T are ExGasR and CoolTemp, respectively.

• Output Register labels should be consistent across the entire system. For example, if
you plan to represent Exhaust Gas Left as ExGasL then you need to use the same label
for all of the generators.

6. When you have completed all of the necessary site-specific modifications, click File >
Send & Save from the node diagram to write your changes to the powermeter.

7. Restart the ION Log Inserter Service after configuring the generator frameworks.

Generator PerformanceGuide ION Power Meter Configuration
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Non-ION Power Meter Configuration
This chapter provides information about configuring non-ION powermeters for Power
Monitoring Expert - Data Center Edition.

WARNING
UNINTENDED OPERATION

• Do not use the powermeters for critical control or protection applications where human
or equipment safety relies on the operation of the control circuit.

• Refer to your meter's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Supported Power Meters
The PowerMonitoring Expert - Data Center Edition can use the following non-ION power
meters for the Equipment PerformanceModule:

• PowerLogic Series 800 PowerMeters PM850 and PM870. Refer to "Configuring PM800
Series Meters" on page 28.

• Momentum PLC. Refer to "ConfiguringMomentum PLC" on page 44.

• SER-3200 PowerMeter. Refer to "Adding the SER3200 toManagement Console" on
page 57.

Prerequisites
The following prerequisites must be completed before attempting to configure a non-
ION powermeter to record data from generators and other equipment for the :

• PowerMonitoring Expert - Data Center Edition is installed and operational.

• All meters must be installed and communicating.

• The following status signals for each ATS are physically wired to the digital inputs on the
appropriate meters.

• Normal

• Emergency

• Test

• Power Outage (optional)

Generator PerformanceGuide Non-ION Power Meter Configuration
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• The following status signals for each generator are physically wired to the digital inputs on
the appropriate meters.

• Start (optional)

• Run

• Stop

• The following generator electrical data aremetered and available for each generator:

• Currents: A, B, C, N, Avg

• Minimum Apparent Power Total

• Minimum Real Power Total

• Frequency

• Real Power Total

• Apparent Power Total

• Voltages: A-B, B-C, C-A, L-L Avg, A-N, B-N, C-N, L-N Avg

• The following signals for each generator are physically wired to the analog inputs on the
appropriate meters. The number of analog inputs required depends on how many
measurements are being recorded. For example, analog data can include the following:

• Exhaust Gas Temperature left and right

• Engine Coolant Temperature in and out.

• Engine Oil Pressure

Configuring PM800 Series Meters
This chapter describes how to use PowerLogic™ ION Setup to configuremeters for the
PowerMonitoring Expert - Data Center Edition. This chapter does not explain how to add
powermeters to the system or how to use ION Setup.

• For information about addingmeters to the system, refer to theManagement Console
online help or theManagement Console section of theStruxureWare PowerMonitoring
Expert User Guide.

• For information about ION Setup software, refer to ION Setup online Help or the
PowerLogic ION Setup User Guide.

For more information about configuring the PM800 series meters using ION Setup software:

• Additional Device Support in ION Setup in the ION Setup online help

• PowerLogic ION Setup Device Configuration Guide



Add PM800 Series Meters to a Site in ION Setup
Use ION Setup to add PM850 or PM870meters to the site.

1. In the devices area, right-click and select Insert Item. TheNew Network Item screen
appears.

2. SelectMeter and click OK. TheNew Device screen appears.

3. Select theGeneral tab

4. In the Type list, select PowerLogic PM800 Series Power Meter.

5. Select theDisplay tab. In the Template Options box, select the type of meter you are
adding.

6. Click OK to add themeter.

7. In the Network Viewer (left pane), click themeter icon. The setup screens appear in the
Content Viewer (right pane).

The following image shows a partial list of the setup screens. Use the I/O Setup, Onboard
Alarms/Events, andData Log setup screens to access the parameters that need to be
configured. The remaining topics in this chapter describe the parameter changes that are
required.

Generator PerformanceGuide Non-ION Power Meter Configuration
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Formore information about adding PM850 or PM870meters to a site in ION Setup, refer to
the following:

• ION Setup online Help

• PowerLogic ION Setup Device Configuration Guide, "PM800 series powermeter" section

• PowerLogic ION Setup User Guide, "Adding and Configuring Devices" section

Configuring Digital and Analog Inputs
This section describes how to configure the digital and analog inputs for the PM800meters.
The instructions assume that you are using separate PM800 series powermeters to record
data for generators.

WARNING
UNINTENDED OPERATION

• Do not use themeters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Refer to your meter's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Configure Digital Inputs
1. In the Content Viewer, double-click I/O Setup to access the Digital Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.

The following image shows Digital In A-S1 selected.



3. Update the Label field with a name that ends with the $ character.

The $ character activates the translated device dynamic labeling feature. If the $ 
character is not used, the default label is used.

• For a generator, examples of labels are EPSS_Start$, EPSS_Run$, and EPSS_
Stop$.

4. SetMode to Normal, Pulse Weight to a non-zero value, for example 100, and leave
Units set as NoUnits.

5. Click OK to update the parameters and to close the dialog.

6. Repeat the steps above for each I/O point that you want to configure.

7. Click Send to save the changes and send the configuration to themeter.

Configure Analog Inputs
PM800 series powermeter Analog Inputs are only available when you install the PM8M2222
Input/Output module on themeter.

Refer to thePowerMeter Input/Output Module PM8M2222, PM8M26, PM8M22 Installation
Manual for more information about installing the input/output module. Obtain this installation
manual at www.powerlogic.com. Select the country, and thenEnergy and Power Quality
Meters > PowerLogic Multifunction Power Meters > PM800 Series > Downloads >
Tech Publications.

1. In the Content Viewer, double-click I/O Setup to access the Analog Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.

The following image shows Analog In A-AI1 selected.

Generator PerformanceGuide Non-ION Power Meter Configuration
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3. Click Edit to open the parameter window for the I/O point and update the Label field with a
name that ends with the $ character.

For a generator, examples of labels for analog inputs are Exhaust Gas L$, Exhaust
Gas R$, and Coolant T$.

The following image shows the label updated to Exhaust Gas L$.

4. Click OK to update the parameters and to close the dialog.

5. Repeat the steps above for each I/O point that you want to configure.

6. Click Send to save the changes and send the configuration to themeter.



Configuring Onboard Alarms and Events
For each digital input configured in I/O Setup, you need to configure the alarms to record
when the digital input on a generator changes from OFF to ON, and also from ON toOFF.

Configuring Digital Input Alarms for Generators
This section assumes that you configured digital inputs Digital In A-S1 as EPSS_Start$,
Digital In A-S2 as EPSS_Run$, andDigital In A-S3 as EPSS_Stop$. Youmust configure
an alarm for the digital input change from OFF to ON and from ON toOFF.

EPSS_Start$: Digital input change from OFF to ON
Complete the following steps to configure an alarm when a digital input changes from OFF to
ON.

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDigital In A-S1 input selected and its label EPSS_
Start$

4. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Digital In A-S1 toStart ON.
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7. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

When the status for EPSS_Start$ changes to ON, Data Log 1 records all channels
currently configured on it.

EPSS_Start$: Digital input change from ON to OFF
Complete the following steps to configure an alarm when a digital input for EPSS_Start$
changes from ON toOFF.

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog. NOTE: If the 12 available digital input alarms have been
configured, you need to re-configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Start$ from the list.



4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStart OFF.

6. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and
from ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O
points are Digital In A-S1, Digital In A-S2, and Digital In A-S3:

Digital Input Label Maps to Alarm Status Alarm Name
EPSS_Start$ Digital In A-S1 Status Input On Start ON
EPSS_Start$ Digital In A-S1 Status Input Off Start OFF
EPSS_Run$ Digital In A-S2 Status Input On RunON
EPSS_Run$ Digital In A-S2 Status Input Off RunOFF
EPSS_Stop$ Digital In A-S3 Status Input On StopON
EPSS_Stop$ Digital In A-S3 Status Input Off Stop OFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Define a Digital Alarm for a Single Digital Input
If a single digital input is used to record signals indicating when the generator is running, and
also when the generator has stopped, you need to define the digital alarm as follows.

1. In theDigital Alarm Setup dialog, select the Digital Input/Output point that will be used
to record the alarm. For example, if you configuredDigital In A-S1with a label of EPSS_
Run$, select this I/O point.

2. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

3. Make sure that Enable is selected.

4. In the Label field, change the digital alarm name from Digital In A-S1 toRun ON.

5. Set Priority to High(1), and select Data Log 1 as the data log to use.

EPSS_Run$: Digital input change from ON to OFF
1. Click Add to add another digital input alarm parameter to the list in the left pane of the

Digital Alarm Setup dialog.
2. Select Status Input Off from the list to set the alarm when the digital input changes from

ON toOFF.

3. Select EPSS_Run$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStop ON.

6. Set Priority to High(1), and select Data Log 1 as the data log to use.

7. Click OK to close the dialog.
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8. Click Send to save the changes and send the configuration to themeter.

As a result of this alarm configuration where EPSS_Run$ represents both the Running and
Stopped states for the generator, whenRun ON is TRUE, the signal is recorded as "1", and
whenStop ON is TRUE, the signal is recorded as "0".

Defining the Data Log Parameters
This section explains how to define data log parameters for the digital inputs, analog inputs,
and load profile data. The instructions assume that you use Data Logs 1 and 2. However, you
can use any Data Log that meets your requirements.

Define Data Log Parameters for Digital Inputs
Complete the following steps to define the data log parameters for the digital inputs.

1. In the Content Viewer, double-click Data Log #1 to open theSetup dialog for the data log
parameters.

2. Set Status to Enable and Interval to Only On Event. TheOnly On Event mode appears as
0 in the Interval field of theSetup dialog.

3. Select Channels, click Edit. The Parameter Selection dialog appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
EPSS_Emerg$.

5. Select the IO Point xx Digital State, where xx is the number of the I/O point present on
themeter. Click >> to move the parameter to theSelected box.



6. Repeat steps 4 - 5 for all I/O points available for the ATS or generator.

7. In theAvailable box, expandMiscellaneous and select Present MilliSeconds. Click >>
to move it to theSelected column.

Add all I/O points for a given ATS or generator to the data log to help ensure
that all of the states are recorded in the data log when any state changes.

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Define Data Log Parameters for Analog Inputs and Load Profile
Data

Configure the system to log the analog inputs and load profile data automatically when the
generator state changes to Running. When the generator state is Running, the alarm status
for digital input EPSS_Run$ is ON.

Using ION Setup, the process to configure automatic logging is:

1. Associate Data Log 2 with the digital input alarm Run ON that you previously defined for
EPSS_Run$.

2. Select the parameters for the Analog Input data to be logged in Data Log 2.

3. Select the parameters for the Load Profile data to be logged in Data Log 2.

4. Set the status of Data Log 2 to Auto-Enable.

These steps assume that you use Data Log 2.

Associate Data Log 2 with the Digital Input Alarm Run ON
1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select the digital input alarm Run ON that was defined for I/O point EPSS_Run$. You
previously selected Data Log 1 when you configured this digital input alarm for the
generator.
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4. In theData Logs: group, select 2. Now both 1 and 2 are selected.

5. Click OK to close the dialog.

6. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Analog Input Data to be logged in Data
Log 2
1. In the Content Viewer, double-click Data Log #2 to open theSetup dialog for the data log

parameters.
2. Select Interval and click Edit to open theEnter Logging Interval dialog. Select

Continuous from the list inMode, set Interval to 1minute, and click OK to close the
dialog.



3. Select Channels, click Edit. The Parameter Selection dialog appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
Exhaust Gas L$.

5. UnderAnalog Input, select the IO Point xx Analog Input Value, where xx is the
number of the I/O point present on themeter. Click >> to move the parameter to the
Selected box.

6. Repeat steps 4 - 5 for each analog input available for the generator.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Load Profile Data to be logged in Data
Log 2
1. In theSetup dialog for Data Log 2, select Channels and click Edit. TheParameter

Selection dialog appears.
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2. Expand each of the following categories. Within each category select the parameters
indicated. For each parameter click >> to move it to theSelected column:

a. InCurrents, select Current A, Current B, Current C, Current N, and Current Avg.

b. InMinimum Readings, select Min Apparent Power Total, Min Real Power Total.

c. InMiscellaneous, select Frequency.

d. InPowers, select Real Power Total and Apparent Power Total.

e. InVoltages, select Voltage A-B, Voltage B-C, Voltage C-A, Voltage L-L Avg, Voltage
A-N, Voltage B-N, Voltage C-N, and Voltage L-N Avg.

3. Click OK to close the dialog.

4. Click Send to save the changes and send the configuration to themeter.

Set the Status of Data Log 2 to Auto-Enable
Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs.
Data is recorded in the data log at a defined interval if the loggingmode is set toContinuous.
Logging stops when the alarm ends.

1. In theSetup dialog for Data Log 2, select Status and click Edit. TheSelect Status dialog
appears.

2. In the drop-down list, select Auto-Enable and click OK to close the dialog.



3. Click Send to save the changes and send the configuration to themeter.

You can also use Vista to set a Data Log to Auto-Enable. Refer to "Configure Auto-Enable
Data Logs for CM4000 and PM800 series" on page 41 for more information.

Configure Auto-Enable Data Logs for CM4000 and
PM800 series

This section explains how to use Vista to configure the data logs for PM800 Series Meters
and the CM4000 Series Meters for auto-enable.

Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs.
Data is recorded in the data log at a defined interval if the loggingmode is set to
Continuous. Logging stops when the alarm ends. The following instructions assume that
you associated Data Log 2 with the digital input alarm Run ON for the purpose of logging the
analog inputs and load profile data.

• For PM800 series meters, see "Set the Status of Data Log 2 to Auto-Enable" on page 40.

Use Vista to Set a Data Log to Auto-Enable
Complete the following steps to use Vista to set the status of Data Log 2 to Auto-Enable.

1. Open Vista and select File > New to open an empty workspace.
2. Ensure that the Toolbox is open. If not, select Options > Show Toolbox.

3. In the Toolbox, select aControl Object and drag it to the workspace.

4. Right-click the control object. TheControl Object Configuration screen appears.

5. Click the Link tab. In the Link area, select Custom, and then click Edit Link. TheCreate
Link screen appears.

Generator PerformanceGuide Non-ION Power Meter Configuration

© 2015 Schneider Electric. All rights reserved. Page 41



Non-ION Power Meter Configuration Generator PerformanceGuide

Page 42 © 2015 Schneider Electric. All rights reserved.

6. In theNodes list, double-click themeter name. The associatedmodule directories appear
in theManagers list.

7. In theManagers list, double-click Resets and Triggers.

8. In theModules list, double-click Log Auto-Enables.

9. In theOutput Registers list, select Data Log 2 Auto-Enable.

10.Click OK to save the selection and to close the screen.

11.Double-click the control object in the workspace to set Data Log 2 on themeter to Auto-
Enable.

Verify that Data Log 2 has been set to Auto-Enable
You can verify that Data Log 2 has been set to Auto-Enable by adding a numeric object to the
workspace and linking it to a setup register for the Data Log.

1. In Vista, ensure that the Toolbox is open. If not, select Options > Show Toolbox.
2. In the Toolbox, select aNumeric Object and drag it to the workspace.

3. Right-click the numeric object. TheNumeric Object Configuration screen appears.

4. Click the Link tab. In the Link area, select Custom and press theCtrl key while clicking
Edit Link. TheCreate Link screen for Setup Registers.



5. In theNodes list, double-click themeter name. The associatedmodule directories
appears in theManagers list.

6. In theManagers list, double-click Data Recorders.

7. In theModules list, double-click Data Log 2.

8. In theSetup Registers list, select RE2 Enabled.

9. Click OK to save the selection and to close the screen.

When the numeric object displays "Auto," you have confirmation that Data Log 2 has been
set successfully to Auto-Enable by the control object.
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Configuring Momentum PLC
This chapter describes how to configureMomentum PLC for the system.

For information about installing and configuringMomentum PLC, see the PLC's
documentation at www.powerlogic.com.

WARNING
UNINTENDED OPERATION

• Do not use theMomentum PLC with either PowerMonitoring Expert - Data Center
Edition or ION Setup for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Refer to your PLC's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Add a Momentum PLC to a Site
Use ION Setup to add eachMomentum PLC to a site.

1. In the Network Viewer, right-click the workstation icon and select Insert Item > Site. The
New Site screen appears.

2. Complete the fields to define the new site:

• Name - Add a name to identify the site.

• Comm Link - Select Ethernet.

• Ethernet Options - Select Gateway.

• IP Address - Enter the IP Address for the device.

• Port - Select 502.



3. Click OK to add the site. The new site appears in the Network Viewer.

4. In the Network Viewer right-click the site name and select Insert Item > Meter. TheNew
Device screen appears.

5. Complete the fields to define the PLC:

• Name - Enter a name to identify the device.

• Type - Select Modbus RTU Device from the dropdown list.

• Unit ID - Enter the unit ID for the device.

• Group - Select a group name from the list or enter a name to define a new group.

6. Click theDisplay tab and select theMomentum PLC D16 (EPSS) template option.

7. Click OK to add the PLC to the site.

After a PLC has been added, click its icon in the Network Viewer to display the setup
screens in the Content Viewer. The following image shows a partial list of the setup screens.
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The remaining topics in this chapter describe how to configure the parameters for theClock
Setup, Data Log andStatus Input setup screens.

Setting the Clock

Set the Date and Time
Follow these steps to set or adjust the date and time for the PLC's clock.

1. In the Content Viewer, double-click Clock Setup. TheClock Setup screen appears.
The first time you access this screen, the label under theSelect column is "Device time"
and theDate/Time column shows the current time on the PLC.

2. Select the Date/Time entry and click Edit. TheDate/Time Setup screen appears.

3. Set the desired date and time in theMeter Date andMeter Time fields.

4. Click OK. TheDate/Time Setup screen closes.



The "Device time" label changes to "Update to" and is automatically selected. The check
mark indicates that the new date and time value will be sent to the PLC when you click
Send.

If you clear the check box, the date and time entry reverts to the time currently configured
on the PLC.

Configuring Status Inputs
Follow these steps to configure the status inputs onMomentum PLCs so that data about the
states of the generators is recorded.

1. In the Content Viewer, double-click Status Input 1. TheStatus Input 1 screen appears.
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2. In theParameters box, select Type and click Edit. TheSelect Type screen appears.

3. In the Type box, select Dual(Form "C") and click OK. This parameter generates an event
for both the leading and trailing edges of the signal.

4. Select Invert and click Edit. TheSelect Invert screen appears.

5. In the Invert box, select No and click OK.

6. Select Log File and click Edit. TheSelect Log File screen appears.

7. In the Log File box, select the data log for the status input and click OK.

8. Click Send to save the changes and send the configuration to the PLC.

Keep track of these status inputs for correct mapping to the generator states through the
Generator Test Module . Status inputs for generators, they need to be set to Run and Stop
states.

For example, the following table shows the relationship of Status Inputs on the PLC to the
settings that are applied through theGenerator Test Module .

Momentum PLC Generator Test Module
Slot Position Status Inputs EPSS Device State

1 Status Input 1
ATS1

Test
2 Status Input 2 Normal
3 Status Input 3 Emergency
4 Status Input 4

GEN1
Run

5 Status Input 5 Stop
… … … …

Defining Data Log Parameters for Status Inputs
Complete these steps to define the data log parameters for the Status Inputs.

1. In the Content Viewer, double-click Data Log x, where x is the number for the datalog.
TheSetup screen appears.

2. Select the following parameters and click Edit to configure them in the Parameter
Selection screen:

• Set Status to Enable.

• Set Records to a non-zero value.

• Set Interval to Only On Event.



3. Select Channels, click Edit.

4. In theAvailable box, navigate toStatus Inputs.

5. ExpandStatus Inputs, select an EPSS input state, such as EPSS Input 1 State, click
>> to move it to theSelected column.

6. Repeat steps 4 and 5 for all status inputs available for the ATSs or generators.

7. ExpandReal-Time Clock, selectMilliSeconds and click >> to move it to theSelected
column.

8. Click OK.

9. Repeat steps 1 through 8 for all of the Data Logs that you want to configure.

10.Click Send to save the changes and send the configuration to the PLC.
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Configuring Digital Outputs
The standardMomentum PLC device driver does not support the configuration of digital
outputs. However, you can use theModbus Device Importer (MDI) to define and configure
digital outputs.

The following information assumes that you already configured an Ethernet Gateway site in
Management Console and that you added a device to the site. For more information, see
Setting UpDevices for Ethernet Gateway Communications in the online help for
Management Console or in theStruxureWare PowerMonitoring Expert User Guide.

Configure Digital Outputs in MDI
Complete these steps Modbus Device Importer (MDI) to define and configure digital outputs
on the PLC.

Before proceeding, make a backup copy of theMomentum PLC map and tree files
Momentum_PLC_D16_EPSS.xml andMomentum_PLC_D16_EPSS.ion, respectively.
These files are located in the ..\Schneider Electric\system\translators\ folder.

1. In Management Console, select Tools > System > Modbus Device Importer. The
MDI main console appears.

2. Open the existingMomentum PLC driver configuration:

a. Select File > Open and browse to C:\Program Files (x86)\Schneider Electric\Power
Monitoring Expert for Healthcare\system\translators.

b. Select Momentum_PLC_D16_EPSS.ion.

c. Click Open. The register details appear in MDI.

3. Under ION Map Information, right-click Momentum_PLC_D16_EPSS and select New
Manager. TheAdd New Manager screen appears.

4. In theManager Name box, enterDigital Outputs. In theManager Type box, select
External Boolean Manager. Click OK.

5. Under ION Map Information, right-click Digital Outputs and select New Module. The
Add New Module screen appears.



6. In theModule Name box, replaceExt Bool 1with the correct name, and click OK. In this
example, CR6 is entered.

7. Under ION Map Information, right-click CR6 and select New Register. TheEdit
Boolean_Register screen appears.

8. Update the values forRegister Label, Register Type,Modbus Address, andReset
Type and click OK. An example is shown next.

Use Copy to create other module and register entries
You can createmultiple module and register entries by usingCopy andPaste operations.

1. Right-click amodule name and select Copy.
2. Right-click Digital Outputs and select Paste to add a copy of themodule and registry

entries.

3. To change themodule name, right-click themodule, select Advanced Properties,
change the name for themodule, and click OK.

4. To change the register values in theModbus Register Information area:
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• Label - In the Label column, double-click the register name. Change the label and press
Enter.

• Address - Double-click theModbus register address. Change the address and press
Enter.

5. Repeat steps 1 through 4 above to create and update additional modules.

The following image shows an example of completed entries in theMDI console.

TheModbus registers shown abovemay not match your system. Adjust
the values tomatch your particular Modbus map.

6. Select File > Save to save your changes.

7. Select Tools > Update Device Type to add the configuration to theMomentum PLC.

Create a Control Object and Status Object in Vista
Complete these steps to link a Control Object and a Status Object to anOutput Register that
you defined in theMDI.

1. Open Vista and select File > New to open an empty workspace.
2. Ensure that the Toolbox is open by clickingOptions > Show Toolbox.

3. Select aControl Object in the Toolbox and drag it to the workspace.

4. Right-click the control object. TheControl Object Configuration screen appears.

5. Select the Link tab.



6. Under Link, select Custom and ION.

7. Under Label, select Custom and enter a label for the control object.

8. Under Link, click Edit Link. TheCreate Link screen appears.

a. In theNodes box, double-click the PLC name. Themodule directories appear in the
Managers box.

b. In theManagers box, double-click Digital Outputs

c. In theModules box, double-click CR6.

d. In theOutput Registers box, select Coil 27.
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e. Click OK to save the selection and to close the screen.

9. In theWorkspace, select aStatus Object in the Toolbox and drag it to the workspace.

10.Right-click the status object. TheStatus Object Configuration screen appears.

11.Select the Link tab.

12.Under Link, select Custom and ION.

13.Under Label, select Use node label.

14.Under Link, click Edit Link. TheCreate Link screen appears.

15.Repeat steps a. through e. above.

16.Save the diagram. The following image is an example of the Vista diagram.

You can now use the Control Object to initiate a state change remotely.



Configuring SER3200 Meters
The SER3200 powermeter can be used with the software to record status changes of the
generator contacts in the onboard data logs.

The process to set up the SER3200 with PowerMonitoring Expert - Data Center Edition
includes these steps:

1. Install hardware and configure device communications and digital inputs.
The SER3200 can be configured using the integral webserver of the device. Enter the IP
address of the device in the browser to open the setup page. The default username and
password is “admin”. Refer toSER-3200/SER-2408 Instruction Bulletin: User's Guide for
instructions.

Perform the following steps from theSER-3200/SER-2408 Instruction Bulletin: User's Guide
before proceeding:

2. In your browser, enter your device IP address and press Enter. Log in with admin/admin
for the Login ID and password.

3. Click SETUP, and then click Time. Set the time/clock correctly for your location.

4. Click SETUP, and then click Inputs. Configure all necessary inputs and select the
Enabled checkbox next to each input. When finished, click Apply.
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5. Click SETUP, and then click Groups. Assign a group to each input. When finished, click
Apply.

6. Make sure that you enable logging for all above groups.

NOTICE
UNINTENDED OPERATION

Make sure to enable the logs in the groups section when configuring the device.

Failure to enable the logs in the groups section will result in the inputs not being
available and not appearing in the Generator Performance Tool.



NOTE: For more information on configuring the communications and digital inputs for this
device, see theSER-3200/SER-2408 Instruction Bulletin: User's Guide located on the
PowerMonitoring Expert - Data Center Edition DVD.

7. Add the device in Management Console.

8. Open Vista to verify communications.

9. Use theGenerator Performance Configuration Tool to assignmeasurements for
generators.

See the following sections for instructions on step 2 - 4.

After you complete the above steps, you can generate the Generator Test Report for data
recorded by the SER3200.

WARNING
UNINTENDED OPERATION

• Do not use the SER3200 with either or ION Setup for critical control or protection
applications where human or equipment safety relies on the operation of the control
circuit.

• Refer to your powermeter's technical documentation located on the product DVD for
more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Adding the SER3200 to Management Console
In Management Console, add the SER3200 as an Ethernet device.

NOTE: For proper operation, the devicemust have theUnit ID value set to 1.

Follow these steps to set the deviceUnit ID:

1. As you enter the device details in the Ethernet Device Configuration screen, right-click the
screen and click Advanced.
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The Advanced Properties for the device appear.

2. In the Unit ID field, enter 1.
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3. Click OK.

4. Verify the device status is "Device Connected" as shown next.

Verify Device Communications in Vista
After you add the device toManagement Console, you can open Vista to view the device's
counter, input\output status, and data logs.

Assign Measurements for Generators
After device data is logged into the database, you can assign devicemeasurements using
the Generator Performance Configuration Tool.

Add the device and select themeasurements for the generator as explained in these
sections:

• "Define Generators" on page 69

The required status measurements for the SER3200 are “Digital Input Status X” where X =
input of the SER3200. On theGenerators tab, the selected source andmeasurement are
similar to the following example.
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Generator Performance Configuration Tool
TheGenerator Performance Configuration Tool is a utility that helps you configure the
generators and other equipment for reporting the data and status of the power system. The
generator-related reports will not work until the required parameters are set up in the tool.

Start the Generator Performance Configuration Utility
To start the Generator Performance Configuration Tool, open the StruxureWare Power
Monitoring Expert - Data Center Edition folder on the desktop and double-click the Generator
Performance Configuration Tool shortcut.

TheGenerator Performance Configuration Tool window contains these tabs: Groups,
Generators, Equipment, andRun History. On these tabs, you create the entities and
groups for equipment in the system. You also view data for prior test runs. The tabs contain a
grid area and an editor area, as shown next. The grid area is empty initially but it will be
populated with entries that you create through the editor area. Use the editor area to define
the settings for new items, or to update the settings for an item that you select in the grid
area.
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When you first use the configuration tool, you need to define generators and equipment on
the applicable tabs. After you do this, you define the device groups on theGroups tab. The
device groups are necessary for reporting.

Use the following tabs to configure the tool:

• Groups tab - Define and configure all groups.

• Generators tab - Define, describe and configure the generators.

• Transfer Switches tab - Define, describe and configure the transfer switches.

NOTE: Transfer Switches and Active Transfer Switches (ATS) are not typically part of a data
center solution; you will not need to configure these for PowerMonitoring Expert - Data
Center Edition.

• Equipment tab - Define, describe and configure the equipment.

• Run History tab - Define, describe and configure the run history.

See the following sections for instructions to use each tab:

• "Define Groups" on page 66

• "Define Generators" on page 69

• "Define Equipment" on page 73

• "View RunHistory" on page 74



Use the following common controls for the tabs:

• Help - Click this to view online help for the tab.

• New - Creates a new entry in the grid.

• Delete - Deletes the selected entry from the grid.

• Revert - Returns amodified record to its original values, if OK orApply have not been
clicked.

• OK - Saves all changes and exits the configuration tool.

• Cancel - Exits the tool without saving changes.

• Apply - Saves all changes and leaves the tool open.

TheModified column in the grid area shows the status of the row data:

+ (plus) - a new entry.

* (asterisk) - a modified entry.

! (exclamationmark) - entry needs more information before it can be saved.
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Define Groups
A performance group is a combination of generators and other equipment for reporting. The
Groups tabmust be completed before you can configure and produce any reports.

You can perform the following actions on this tab:

• Click New to create a new group for generating reports. A group can contain any device
that has been configured on the other tabs. See "Edit Groups" on page 66 for instructions
to define the groups.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

• Click theEdit Load Sources to associate a group with the electrical loads that the group
of generators must carry in a power outage. See "Edit Group Load Sources" on page 68 for
instructions.

Edit Groups
TheGroups tab displays the device groups defined in the system. The generators and other
equipment must be defined on their respective tabs before you can add them to a group.

1. Click New to create a group.
2. Complete the following to define the values for a group:

• Name - Enter a unique name to identify the group.



• Generators - Select the generators to include in the group.

• Equipment - Select the equipment to include in the group.

TheSelect All andSelect None options let you work easily with large numbers of
sources by selecting all check boxes or clearing all check boxes at the same time.

3. Click Apply to save the group and remain on the tab.

4. Repeat these steps to create other groups.

Edit Group Priority Levels
TheEdit Priority Levels editor is used to select at least one priority level that you want to
apply to the equipment groups. The default priority level names and transfer times are:

• Critical - 10 sec

• Equipment - 30 sec

• Life Safety - 10 sec

You can change any of these names and transfer times and add new priority levels as
necessary.

1. Click Edit Priority Levels. ThePriority Levels screen appears.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

• Name - Enter a unique name to identify the priority level.

• Required Transfer Time (Seconds) - Enter the transfer time in seconds. This time
indicates themaximum acceptable time it takes the equipment to move from the Test
state to theEmergency state.

• Color - Click the color box to select a color for the priority level. This color appears on
the Generator Capacity Report summary page, where the generator loads are
compared.

4. Click OK to save the priority level and return to theGroups tab.
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Edit Group Load Sources
On theEdit Load Sources screen, you can associate an equipment group with the various
electrical loads that the equipment must carry during a power outage.

Define the priority levels for the system before you configure load sources. See "Edit Group
Priority Levels" on page 67 for instructions.

1. Click Edit Load Sources. TheSelect Load Sources screen appears.

2. Click New to add a load source.

3. Complete these fields:

• Source - Select themeasurement source.

• Measurement - Select themeasurement to monitor.

• Priority Level - Select the priority level to assign to the load source.

4. Click OK to save the new load source and return to theGroups tab.

You can use theClone button to associate an equipment group with several sources
where the load is logged against the samemeasurement. The cloned group contains the
samemeasurement and priority level as the original.



Define Generators
Use theGenerators tab to create or update entities representing the generators in the power
supply system. Complete this tab if you need to produce reports for generators.

You can perform the following actions on this tab:

• Click New to define the properties of the generators in the system. See "Edit Generator
Properties" on page 69.

• Click Clone to define a new generator that is similar to an existing generator. The system
copies many details of the existing device into the new entry. You can then enter the
unique details of the new device. If you need to define several devices that are similar,
this feature can help you define them quickly. See "CloneGenerator Properties" on page
70.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

Edit Generator Properties
TheEdit Generator area on the tab is used to create a generator entry and to define specific
values for it.

1. On theGenerator tab, click New.
2. Complete the following fields to define a generator.
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• Name - Enter a unique name to identify the generator.

• Description - optional. You can add specific information about the generator, such as
make andmodel.

• Electrical Data

• Source - Select a source name. The source represents the device that
records the electrical data from the generator.

• Prime Nameplate Rating - Enter themaximum power load for the
generator. Refer to the generator's nameplate for this value.

• Unit - Select the unit of measurement for the power load.

• Battery Waveform - optional. Use this area to if you want to configure and generate the
Battery Health Report. To enable the report, check the box and complete these fields:

• Source - Select a source name that is performing the waveform capture.
This option is only available for ION 7650meters.

• Measurement - Select themeasurement recording the battery waveform.
For a typical configuration, this is the V4 waveform.

Specific frameworks for the battery voltage waveform must
also be configured. See "Generator Battery Health" on page
83 for additional instructions.

• Status Measurements - These fields are not required.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other generators.

5. If you are defining several similar generators, use theClone button. See "CloneGenerator
Properties" on page 70.

Clone Generator Properties
You can use the clone feature to copy the properties of an existing generator entity and use
those properties as the baseline for multiple generators. The clone feature can help you
define several similar generators quickly.

1. On theGenerators tab, select the generator you want to use as the baseline for another
generator.

2. Click Clone to create a new generator based on a selected entity. Many fields are copied
from the selected generator. The fields which are not copied have an information icon to
indicate where you need to enter data, as follows:

• Name - Enter a unique name to identify the generator.

• Electrical Data -Source - Select a source name from the dropdown list. The source
represents the device that records the electrical data from the generator.

• Status Measurements -Source - Select a source name. The source represents the
metering device that records the status of a generator.

For information about other generator properties, see the previous section .

3. Click Apply to save the new generator entity.



Edit Engine Data
TheEngine Data Measurements editor is used to define engine data values and other
custom data values for generators. The items beingmeasured, typically analog data, can
differ from generator to generator. Battery voltage and coolant temperature are two common
measurements.

If you want to use the Smart Device Data Collector to log generator data, add the engine data
values you need. These values can also be reported on the Trend Report, Tabular Report,
Test Report, and dashboard gadgets.

Follow these steps to add engine data values and other custom data values.

1. Click Edit Engine Data to open theEdit Engine Data Measurements editor.

2. Click New to enable the input fields.

3. Complete the following to define new data values:

• Name - Enter a name for the data value.

• Units - Enter a unit of measure for the data value.

4. Click OK to save the new data value and return to theGenerators tab.

Next, assign these data values to generator measurements. See "Assign Engine Data" on
page 72 for instructions.
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Assign Engine Data
TheEngine Data Measurement editor is used to associate engine data values with specific
generator measurements. See "Edit Engine Data" on page 71 for instructions to define
custom engine data values.

1. Click Assign Engine Data to open theAssign Engine Data Measurement editor.

2. Click New.

3. Complete these fields to associate a data value with a specific measurement:

• Engine Data Measurement - Select the data value. The dropdown list contains all of
the data values that were configured on the Edit Engine DataMeasurements screen. 

• Source - Select the device name that records the generator data.

• Measurement - Select themeasurement for the data value.

• Data Collector - Check this option to enable users to enter measurement data through
the Smart Device Data Collector web tool. See "Smart Device Data Collector" on page
119. This data can also be included in the Test Report.

4. Click OK to save your changes and return to theGenerators tab.



Define Equipment
Use theEquipment tab to create a logical device with a sourcemeasurement and rating.
You can add these logical devices to device groups for reporting. Complete this tab if you
need to produce reports for equipment capacity.

You can perform the following actions on this tab:

• Click New to enter new record for a device. See "Edit Equipment Sources" on page 73 for
instructions to define the devices.

• Click Clone to copy an existing record andmakeminor changes. The system copies
many details of the existing device into the new entry. You can then enter the unique
details of the new device. If you need to define several devices that are similar, this
feature can help you define them quickly.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

Edit Equipment Sources
TheEquipment tab displays the equipment load sources andmeasurements defined in the
system.

1. Click New to create a record.
2. Complete these fields:
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• Name - Enter a unique name to identify the record.

• Description - Enter additional information about the device. Optional.

• Source - Select the load source for the device.

• Measurement - Select themeasurement for the device.

• Rating - Enter themaximum rated load for the device.

• Unit - Enter the unit of themeasurement.

3. Click Apply to save the record and remain on the tab.

4. Repeat these steps to enter additional devices.

View Run History
Use theRun History tab to view ormodify run activities that represent the Test, Load
Shedding, and Power Outage activities that have occurred in the system. The history
indicates when components of the power system have become active, such as when a
generator was running. The runs stored in history can be used as input for reports and
dashboards.

Because the system stores the history of these activities, you can generate useful reports
about the equipment operation. The reports can identify when the system was active, why
the system was active, and what devices were active.



The first time the history records are generated on theRun History tab, the systemmay
take a long time depending on the amount of history present in the system. When changes
occur in the equipment configuration, the run history must be generated again.

For example if you remove a generator from a group, the run history for that group needs to be
rebuilt because that generator may have been the reason for the detection of a run. Now that
the generator is not part of the group, the system needs to build the run history again to have
accurate data.

You can perform the following actions on this tab:

• Click Detection Options to modify the criteria of a run event that will cause it to appear
on this tab. See "Modify Run Detection Options" on page 75.

• Click Refresh Run History to update the tab with the latest run events that have
occurred in the system.

• Click Delete Run History to remove all run event records from the tab.

• Modify the name and run reason for a run event. See "Modify Run Details" on page 76.

Modify Run Detection Options
The run detection options can be defined to help guard against bad data in the system. To
record actual run activities, you can set the parameters so the system only records runs that
fall within the criteria.

Theminimum run length value is present to prevent false positives, whichmay occur during
commissioning when the states of the generators are changing quickly and seemingly at
random. This may be due to signals being recorded that really do not reflect actual generator
activity.

You can set themaximum run length to eliminate "hanging" runs. A hanging run occurs when
the stop signal for a generator is not recorded properly. As a result, every week during the
test it records a running signal but there is no way for the system to know when it stops. If
the system does not see a stop signal, it sets the end of the run to be the start of the run plus
themaximum run duration. Therefore you cannot determine how long the generator was
actually running.

Complete the following steps to define the run criteria for the system to store runs in history.

1. Click Detection Options. TheRun Detection Options screen appears.

2. Change the values in theminimum andmaximum fields.

3. Click OK to save the changes and return to theRun History tab.
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4. Click Refresh to update the tab with the run events that match the new detection criteria.

Modify Run Details
The system defines run data, such as name, start time, end time, reason, and active sources
automatically. You can change the name of the run event and the reason for the run.

• The default run name is the start date of the run, such as June 12 2011. If a group has
multiple runs on the same date, the subsequent runs have the same date with the run
number appended, such as June 12 2011 Run 2 and June 12 2011 Run 3.

• The system automatically detects the reason for the run. If the detected reason is
incorrect, you can change the reason. For example, the reason appears as Test, but the
run is actually Load Shedding.

Other details about the run event cannot bemodified directly. If the sources for a run are not
correct, you can exclude or include specific sources when generating a report based on this
run.

1. Click the run record you want to modify. The run details appear below the grid.
2. In theName field, change the suggested run name as necessary.

3. In theReason list, select the correct reason for the run.

4. Click OK to save the changes for the run.



Generator Activity Report
TheGenerator Activity Report shows the test run hours and other test run data for each
generator in the selected group.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report:

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Specify the requiredmeasurement source, nameplate rating, and unit of
measurement.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.

• For Generator Performance Configuration Tool, see "Define Generators" on page 69.
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Configure and Run the Generator Activity Report
Use the PowerMonitoring Expert - Data Center EditionWeb Application Reports feature to
configure and produce the Generator Activity Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator
Performance Configuration Utility.

1. In the Reports Library, expand theGenerator Performance folder and click Generator
Activity Report.

The report template appears.

2. Complete the fields to define the report.

• Title - Enter a name for the report.

• EPSS Group - Select the group for which the report is intended. When you select a
group in the list, the field to the right shows the devices included in the group.

• Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Reporting Period - Select the date range for the data you want to include. This can be
a fixed number of prior days, such as Last 7 Days, or a fixed date range. The initial
setting is Last 7 Days. In the US, select at least 30 days of load data recorded at 15
minute intervals to satisfy regulations. Also select the type of timestamp to use in the
report, either Server Local Time or UTC (Universal Time).



• Threshold (Hours) - Enter themaximum number of hours the generators should run in
non-emergency use. Enter a value that is in compliance with local authority
requirements. For example, in the US, the EPA requires that generators can run no
more than 100 hours in non-emergency use.

• Include Activity Details - Click Yes to include the generator details in the report. Click
No to exclude this section.

• Include Data Warnings - Click Yes to include data warnings in the report. If there are
none, the section is not included. Click No to exclude this section.

3. Click Generate Report to produce the report.
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Generator Activity Report Example

Summary Page
The first page of the report shows the title, company name, group, a bar graph representing
the test run hours on each generator, and a table of test run data for each generator.

Details Page
The details page shows a pie chart of the type of hours for each generator and the total run
time table.
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Generator Battery Health
Overview

TheGenerator Battery Health system contains several components that provide the
customer with information about the generator battery bank. Specifically, themonitor shows
the customer the starting voltage signature, which indicates the battery bank’s voltage drop
and recovery during and after starting the generator.

The following tasks must be completed to set up the Generator Battery Health system:

• Install and configure the ION7650meter to the battery bank to bemonitored. Refer to the
PowerLogic ION7550 / ION7650 Installation Guide andPowerLogic ION7550 / ION7650
User Guide for more information. Obtain the latest version of these documents from
www.schneider-electric.com.

Note the following:

• V1 - V3 voltage inputs must have PTs in order to isolate the ground from
the system beingmonitored and the battery.

• Connect V4 to the positive side of the battery. Input impedence of V4
terminal is 5Mohm (phase - Vref). For themost up to date specification,
contact the local representative.

• Connect Vref to battery ground.

• Fusingmust be installed according to themeter installation instructions.

• Perform visual inspection of connections to help ensure there is physical
separation between the system connected to V1, V2 and V3, and the
battery connected to V4.

• For other wiring options with PTs, see thePowerLogic ION7650
Installation Guide.

DANGER
EQUIPMENT ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Treat the battery circuit as energized to the category of the installation.

Failure to follow these instructions will result in death or serious injury.

Generator PerformanceGuide Generator BatteryHealth

© 2015 Schneider Electric. All rights reserved. Page 83



Generator BatteryHealth Generator PerformanceGuide

Page 84 © 2015 Schneider Electric. All rights reserved.

Refer to the following diagram as an example for connections to themeter.

• Configure the Battery Health Framework to capture the battery voltage signature or
waveform and deploy the framework to themeter. See the next section for instructions.

• In the Generator Performance Configuration Tool, check the Battery Waveforms option for
the generator to be included in the customer's Battery Health report. See "Edit Generator
Properties" on page 69 for instructions.

• Configure the Generator Battery Health Report to display the graph of the voltage
signature. The customer can use the report to help understand the battery bank
condition. The report can display multiple generators for the same starting date or a
single generator onmultiple starting dates. See "Configuring and Running the Battery
Health Report" on page 93.

This chapter provides instructions for configuring the framework to capture the voltage
signature.

Configure the Battery Health Framework
The Battery Health Framework is designed to capture and record a generator’s battery
voltage signature at start up. This voltage signature provides some indication of the health of
the generator’s battery bank. A typical waveform capture of the voltage drop when starting is
shown next:



Note the following items about this example:

• This capture shows about 4 - 5 seconds worth of data, accomplished via 3 waveform
recorders in series configured at a resolution of 16x96.

• The voltage does not immediately recover to its original value (~26 v) but it begins to ramp
up.

• There is about 0.5 seconds of data before the voltage drop to approximately 20 v.

Two options in the framework are possible to capture the waveform, based on how the crank
relay signal is triggered - pulse or KYZ.

Example Framework
The following figure shows the typical modules for the framework.

The types of module used are:

• Data Acquisition
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• Digital Input

• Convert

• OneShot Timer

• Waveform Recorder

See the following descriptions for the way eachmodule works in this framework.

Refer to ION Reference for details on how eachmodule operates and for settingmodule
parameters.

Data Acquisition – Data Acqn 1

The V4 signal from themeter goes to the Data Acquisitionmodule.

Digital Input – G1 Crank Relay

This module accepts the Cranking Relay signal from the field. When the signal goes high, the
logic to record the battery voltage triggers.

The Input mode can be set to Pulse or KYZ, as explained next.



Pulse Input Mode
When the Crank Relay signal goes high, a pulse is generated on the Trigger output register,
labeled "G1Crank Relay." The setup registers for the Digital Input module are shown next.

Note that the Input Mode value is Pulse. The Trigger output can now be fed into the first
Waveform Recorder along with V4 from the Data Acquisitionmodule.

KYZ Input Mode
If you are using the sameDigital Input to handle the Generator Start signal (EPSS_Start) it is
probably set to KYZmode.

Input Mode KYZmeans that a pulse is generated on the Trigger output register when the
Crank Relay signal goes high AND when it goes low. The Convert module and One Shot
Timermodule (explained later) prevent triggering the downstream logic twice.

Generator PerformanceGuide Generator BatteryHealth

© 2015 Schneider Electric. All rights reserved. Page 87



Generator BatteryHealth Generator PerformanceGuide

Page 88 © 2015 Schneider Electric. All rights reserved.

The Crank Relay Module is setup like this:

Note that the Input Mode value is KYZ.

Convert
The signal from the Digital Input module cannot be fed directly into the One Shot Timer. The
Convert module converts the digital signal to analog for the One Shot Timer.

One-Shot Timer
To prevent triggering the downstream logic twice, send the state (EPSS_Start) from the
Convert module into the One Shot Timer:

Send the output register into the first Waveform Recorder G1 Battery 1.



First Waveform Recorder – G1 Battery 1
The Data Acquisitionmodule andG2Crank Relay module are the inputs to the first
Waveform Recorder, labeled “G1 Battery 1.”

These are the setup registers for themodule:

Note the following about the setup registers:

• Depthmust be non-zero – 100 is a good number.

• RecordMode should be Circular.

• Format should 16x96. This means 16 samples per cycle and 96 cycles, so at 60 Hz this
results in approximately 1.6 seconds worth of data.

• Record Delay Cycles is set to 95 to allow the “window of observation” to move so that
only post-event data is captured. Refer to ION Reference for more details.

Second and Third Waveform Recorders
The secondWaveform Recorder - G1 Battery 2 - is cascaded with the first to capture another
1.6 seconds of the battery voltage signature. Do this by using the Record Complete output
register on G1 Battery 1 as a flag to trigger G1 Battery 2 to start recording.
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The thirdWaveform Recorder - G1 Battery 3 - is cascaded with the second recorder to
capture the final 1.6 seconds of the battery voltage signature. As above, use the Record
Complete output register on G1 Battery 2 as a flag to trigger G1 Battery 3 to start recording.

The Setup Registers should be the same as first waveform recorder with different labels.



Battery Health Waveform Capture Results
After the framework is complete, in Vista you should see the voltage signature that looks
similar to the illustration shown next.

After you obtain this type of result, you can configure the generator in the Generator
Performance Configuration Tool and define the Battery Health Report in the Power
Monitoring Expert - Data Center EditionWeb Applications Reports feature. Refer to these
sections for instructions on these tasks.

• "Edit Generator Properties" on page 69.

• "Configuring and Running the Battery Health Report" on page 93.
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Generator Battery Health Report
TheGenerator Battery Health Report shows the captured waveform image of the
generator voltage when the generator starts.

The waveform image includes a reference waveform that shows the initial voltage signature
when the batteries were first installed and tested. The reference waveform helps compare
the current battery condition to their initial condition.

Research has indicated that when a battery begins to fatigue, the waveform for the voltage
during start-up changes. The voltage waveform can be captured and stored in the system for
ongoing analysis.

By capturing the voltage waveform when the batteries are in a known good condition,
subsequent waveforms can be compared to it to identify changes. In the Generator Battery
Health report, you can compare waveform images to see the changes over time. Adverse
changes in the waveform indicate a degradation of battery condition.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report:

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Themeasurement source, nameplate rating, and unit of measurement
are required.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.



• Battery Waveforms - Select the source and themeasurement. Configure themeters that
provide thesemeasurements. Also, configure the frameworks as described in "Generator
Battery Health" on page 83.

• "Edit Generator Properties" on page 69.

After these required items are defined, the report can be configured and generated, as
described next.

Configuring and Running the Battery Health Report
Use the PowerMonitoring Expert - Data Center EditionWeb Application Reports feature to
configure and produce the Generator Battery Health Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator
Performance Configuration Utility.

1. In the Reports Library, expand theGenerator Performance folder and click Generator
Battery Health Report.

The report template appears.

2. Complete the fields to define the report.

• Title - Enter a name for the report.

• Select EPSS (Generator) Group - Select the generator group for which the report is
intended. The list shows the groups that include generators that can record the battery
voltage waveform via ION 7650meter. When you select a group in the list, the field to
the right shows the devices included in the group.

• Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.
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c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Select Generator Starts - Select the option to specify the start records. If you click
Select Reference Starts you can choose the specific start records by generator and
date. For example, you can use this option to compare yesterday's Gen 1 start voltage
signature to the Gen 1 start voltage signature from six months prior.

• Include Data Warnings - Click Yes to include the data warnings in the report. If there
are no data warnings, the section is not included in the report. Click No to exclude this
section.

• Cumulative Degradation Threshold - Enter the value that represents themaximum
total voltage difference between the reference waveform and the evaluated waveforms.
For example, if the waveform is off by 1.0 on each point from the reference, the total
degradation is 10. If the threshold value is 8, then the degradation exceeds the
threshold.

3. Click Generate Report to produce the report.



Battery Health Report Example
In this example, the starting voltage waveform (blue) is very similar to the reference
waveform (red). The drop to 20 VDC is the point at which the generator started. After the
start, battery voltage rises to normal state of charge after the start.

Generator PerformanceGuide Generator BatteryHealth

© 2015 Schneider Electric. All rights reserved. Page 95



Generator BatteryHealth Generator PerformanceGuide

Page 96 © 2015 Schneider Electric. All rights reserved.

Generator Battery Health Export
TheGenerator Battery Health Export report is based on the same data as the graphic-
based report. The export version provides the raw data in CSV file format. The export file can
be imported by other systems, such as Energy Operation.

Configure and Run the Generator Battery Health Export
Use the PowerMonitoring Expert - Data Center EditionWeb Application Reports feature to
configure and produce the Generator Battery Health Export file.

1. In the Reports Library, expand theGenerator Performance folder and click Generator
Battery Health Export. The report template appears.

2. Complete the fields to define the report.

• Title - Enter a name for the export file.

• When you select a group in the list, the field to the right shows the devices included in
the group.

• Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Select Generator Starts - Select the option to specify the start records. If you click
Select Reference Starts you can choose the specific start records by generator and
date. For example, you can use this option to compare yesterday's Gen 1 start voltage
signature to the Gen 1 start voltage signature from six months prior.



• Cumulative Degradation Threshold - Enter the value that represents themaximum
total voltage difference between the reference waveform and the evaluated waveforms.
For example, if the waveform is off by 1.0 on each point from the reference, the total
degradation is 10. If the threshold value is 8, then the degradation exceeds the
threshold.

3. Click Generate Report to produce the report.

Battery Health Export Example
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Generator Load Summary Report
TheGenerator Load Summary Report provides a summary graph of electrical data during
a generator run. The report includes a load curve, minimum-maximum-average load
summary, and other electrical details.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report.

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Themeasurement source, nameplate rating, and unit of measurement
are required.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.

See "Define Generators" on page 69 for instructions on the above settings.
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Configure the Generator Load Summary Report
Use the PowerMonitoring Expert - Data Center EditionWeb Application Reports feature to
configure and produce the Generator Load Summary Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator
Performance Configuration Utility.

1. In the Reports Library, expand theGenerator Performance folder and click Generator
Load Summary Report.

The report template appears.

2. Complete the fields to define the report.

• Title - Enter a name for the report.

• EPSS Group - Select the group for which the report is intended. When you select a
group in the list, the field to the right shows the devices included in the group.

• Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Use Run History - Select this if you want to select themost recent run or select other
specific runs that are stored in history, and do the following:

• Click Refresh Run History to populate theRuns list with the latest run
records.



• In theRuns list, select Most recent run or the specific run record.
The date and reason for the run appear below the dropdown list.

If you select Most recent run and define excluded
sources, the exclusions are ignored when you generate the
report.

• Select Date Range - Select this if you want to select the runs according to a date range
and run reason, and do the following:

• Select theReporting Period date range for the runs to include in the
report.

• Select theRun Reason for the runs to include in the report.

• Include Electrical Details - Click Yes to include the electrical details in the report.
Click No to exclude this section.

• Include Data Warnings - Click Yes to include data warnings in the report. If there are
none, the section is not included. Click No to exclude this section.

3. Click Generate Report to produce the report.
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Generator Load Summary Report Example
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Generator Test Report
TheGenerator Test Report shows the run details and overall status for generators and
transfer switches in the group. For example, the report shows the transfer time of the lead
ATS and indicates whether the transfer time passes or does not pass the test requirements.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report.

Generators Tab
• Name - Enter a name for the generator entity.

• Electrical Data - Enter themeasurement source, nameplate rating, and unit of
measurement.

• Status Measurements - Enter the source of the status measurement and the start, run,
and stop values. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but you can change this to accommodate
customer requirements.

See "Define Generators" on page 69 for instructions on the above settings.

Groups Tab
• Name - Enter a name for the group entity.

• Select at least one entity from theGenerators, Transfer Switches, orEquipment lists.
The group can contain entities from each list combined.

See "Define Groups" on page 66 for instructions.

After these required items are defined, the report can be configured and generated, as
described next.

Configure and Run the Test Report
Use the Reports module of PowerMonitoring Expert - Data Center Edition to configure and
produce the Generator Test Report.

1. In the Reports module, expand theGenerator Performance folder and click Generator
Test Report.

The report template appears.
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2. Complete the fields to define the report as described in the next sections.

Enter a Title, Company Name, Technician Name
Enter the appropriate information in the following fields:

• Title - Enter a title for the report. For example, youmight call the report the Generator
Operation Report.

• Company Name - Enter the name of your organization.

• Technician Name - Enter the name of the person who prepared the report.

Include Data Warnings
Select the appropriate option to include or exclude the data warnings table.

• Yes - Include a table of data warnings in the report. If there are no data warnings, the table
is not included in the report.

• No - Exclude a table of data warnings from the report.



Specify Run Information
Complete the following steps to select the report mode, EPSS group, and source exclusions.
You can configure the Test report to generate based on detected runs in history or based on
runs in a date range and run reason.

1. In theEPSS Group list, select the group that the Generator Test Report is intended for.
When you select a group in the list, the field to the right shows the devices included in the
group.

2. Click Exclude Sources to select the devices in the group that you want to exclude from
theGenerator Test Report.

TheEPSS Group Exclusion Summary screen appears. This lets you refine the report
so that devices do not appear in the report if they are not available when the test is run.

• In theSources Included area, select the check boxes for the sources to be
excluded. Click > to move those sources to theSources Excluded area.

• Tomove all of the sources into theSources Excluded area, click >>.

• Tomove excluded sources back to the Included Sources area, select the sources and
click < or click << to move all sources.

• Click OK to save your selections and return to the report template.

3. Select Use Run History if you want to select themost recent run or select other specific
runs that are stored in history, and do the following:

• Click Refresh Run History to populate theRuns list with the latest run records.

• In theRuns list, select Most recent run or the specific run record. The date and
reason for the run appear below the dropdown list.

If you select Most recent run and define excluded sources, the
exclusions are ignored when you generate the report.

4. Select Select Date Range if you want to select the runs according to a date range and run
reason, and do the following:

• Select theReporting Period date range for the runs to include in the report.

• Select theRun Reason for the runs to include in the report.

The devices in the group will appear in theSources section of the Generator Test Report.
Devices that you excluded from the report will be gray-shaded.

Configure the Generator Summary
Complete the following steps to configure theGenerator Summary section of the
Generator Test Report.

1. Click Generator Summary.
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2. Select the Include Generator Summary check box to include theGenerator Summary
section in the Test Report. The remaining options become enabled. Clear this check box
to exclude theGenerator Summary section from the report.

3. Select the Include Pass/Fail Indicator check box to include both the pass/fail grade and
the test method used to evaluate each generator. The pass/fail grade is based on both the
run duration and theminimum specified percentage of the prime nameplate rating. Clear
this check box to exclude the pass/fail grade and the test method from the report.

4. Select the options underElectrical Data to specify electrical data in the report.

• Include Chart - Select this check box to include a generator chart showing kW Load,
kVA Load, and the threshold for theminimum acceptable power load based on the
specified load percentage for the run duration.

• Include Avg, Min, Max Table - Select this check box to include a table showing
minimum, average, andmaximum electrical readings for the longest continuous load at
(or above) the specified load percentage. The electrical readings measured are: kW,
kVA, Ia, Ib, Ic, In, Vab, Van, Vbc, Vbn, Vca, Vcn.

• Include Details - Select this check box to include a table showing the generator
electrical details. The data is organized by time intervals and displays the readings for
kW, kVA, load (the percentage of maximum load identified on the generator nameplate),
Power Factor (PF), I avg, VLL avg, VLN avg, and Frequency.

5. Select the options underEngine Temperature Data to specify engine temperature data in
the report.



• Include Chart - Select this check box to include a chart showing the engine
temperature for the run duration, and a horizontal line identifying theminimum
temperature required for the run duration.

• Include Avg, Min, Max Table - Select this check box to include a table showing
Minimum, Average, andMaximum engine temperature readings for the longest
continuous engine temperature equal to or above theminimum acceptable engine
temperature.

• Include Details - Select this check box to include a table showing the Longest
Continuous ET (Engine Temperature) time period, theMinimum ET, Required Run
Duration (Min), and Actual Run Duration.

Note
The configuration tool does not convert the engine temperature values from one
temperature type to another.

6. Select the options underExhaust Gas Temperature Data to specify exhaust gas
temperature data in the report.

• Include Chart - Select this check box to include a chart showing the exhaust gas
temperature for the run duration, and a horizontal line identifying theminimum
temperature required for the run duration.

• Include Avg, Min, Max Table - Select this check box to include a table showing
Minimum, Average, andMaximum exhaust gas temperature readings for the longest
continuous exhaust gas temperature equal to or above theminimum acceptable
exhaust temperature.

• Include Details - Select this check box to include a table showing the Longest
Continuous EGT (Exhaust Gas Temperature) time period, theMinimum EGT, Required
Run Duration (Min), and Actual Run Duration.

7. UnderEngine Data, select the Include Details check box to include a engine details in
the report. Details for each generator include:

• Generator name.

• Generator start and stop times by date.

• A label to show whether the data was automatically or manually collected.

• A table of measurements, such as battery voltage and coolant temperature. Each
measurement includes a timestamp and the corresponding values.

8. Click OK to save the changes and return to the Generator Test Report template.

Configure the Events Summary
Complete the following steps to configure theEvents Summary section of the Test Report:

1. Click Events Summary to open theEvents Summary screen.
2. Select the Include Events Summary check box to include theEvents Summary

section in the report. The other check boxes become enabled. Clear this check box to
exclude theEvents Summary section from the report.
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3. Select the Include Generator Events check box to include generator events in the report.
Clear the check box to exclude generator events from the section.

4. Select the Include ATS Events check box to include ATS events in the report. Clear the
check box to exclude ATS events from the section.

5. Click OK to save your changes and return to the Generator Test Report template.

Add Comments
In theComments box, enter additional information for the report.

Generate the Report
Click Generate Report to create the report. The layout and content of the report is dependent
on the selections youmade when you configured the report, and on the contents of the
system database.



Generator Test Report Example
The following images are examples of various sections of an Generator Test Report in the
order in which they occur.

Title Page
The title page of the test report shows the title, company name, group, the name of the
person preparing the report, and the test period.

Sources
TheSources section shows the devices in the selected group.

Events Summary
TheEvents Summary section shows the status of the generators in the group.
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Generator Summary
TheGenerator Summary section shows the evaluationmethod is being used to determine
the status of the generator being tested.

This example shows the Load Bank evaluationmethod was used on the generator.

Generator Load Summary
TheGenerator Load Summary section shows a chart of the electrical load data for the
generator being tested.



This is an example showing the Load Bank evaluationmethod was used.

Longest Continuous Load
This section includes a table summarizing theminimum, average, andmaximum electrical
readings for the longest continuous load by load bank stages. The following images show
data for each stage of the load bank test.
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Generator Engine Temperature Summary
This example shows the Load AND Engine Temperature AND Exhaust Gas Temperature
evaluationmethod used on the generator.

This section also includes a chart of the engine temperature readings for the longest
continuous load and a table summarizing theminimum, average, andmaximum engine
temperature readings for the longest continuous load.



Generator Engine Temperature Details
This section shows summarized engine temperature details by time intervals.
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Generator Exhaust Gas Summary
This section shows a chart of the exhaust gas temperature data.

Generator Exhaust Gas Details
This section shows summarized exhaust gas temperature details by time intervals.



Generator Electrical Details
This section shows summarized electrical details by time intervals.

Generator Engine Details
This section shows engine parameter details, such as battery voltage and oil pressure
readings.
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Smart Device Data Collector
The Smart Device Data Collector is a web tool where you canmanage your facility data,
including:

• Log standard data for a generator, including battery voltage, coolant temperature, and oil
pressure. This feature helps you enter more complete data so reports and analysis are
more accurate.

• Log data for custom data values, such as for generator maintenance and cleaning tasks.

PowerMonitoring Expert - Data Center Edition includes several reports that display
generator data submitted through the Smart Device Data Collector, including Generator Test
Report, Tabular Report, and Trending Report. The next section explains how tomake sure
submitted data appears in the reports and gadgets.

The Smart Device Data Collector cannot be used to log data to PowerMonitoring Expert -
Data Center Edition until generators have been set up in the Generator Performance
Configuration Tool.

Generator Data Workflow
Data submitted through Smart Device Data Collector can be included in various reports and
gadgets:

• Generator related data submitted through Data Collector can be included in the Generator
Test Report and show the Run record in the Run History.

• Non-generator data can be included in other reports: Tabular Report and Trending Report.

Follow these steps to configure generators in the Generator Performance Configuration Tool
to work with the Smart Device Data Collector tool.

1. Set up the generator meter in Management Console. See thePowerMonitoring Expert
User Guide for instructions to add and configuremeters in Management Console.

2. Add the generator entity in the Generator Performance Configuration Tool. See "Define
Generators" on page 69 and note the following:

• TheStarting, Running, andStopped state values for the generator must be defined.

3. On theGenerators tab, click Edit Engine Data. On the Engine DataMeasurements
screen, add the custom data values you want to log and report on. See "Edit Engine Data"
on page 71.

4. Save the new data values and return to theGenerators tab.

5. Click Assign Engine Data. On the Assign Engine Data screen, configure the
measurement for each of the data values. See "Assign Engine Data" on page 72 and note
the following:

• Source - Select the generator source.
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• Measurement - Select ameasurement with a name that begins with: WAGES External
Input 1.

• Data Collector - Check this option for the data value.

6. Save the data assignments and return to theGenerators tab.

7. Verify the generator entities are included in a group on theGroups tab. "Edit Groups" on
page 66.

8. Login to the Smart Device Data Collector. See "Start the Smart Device Data Collector" on
page 120.

9. Enter and submit the generator data. See "LogGenerator Data" on page 122.

10.Login to PowerMonitoring Expert - Data Center Edition and view the data in reports:

• Generator Test Report "Generator Test Report" on page 105

• Tabular Report - See thePowerMonitoring Expert Help for instructions.

• Trending Report - See thePowerMonitoring Expert Help for instructions.

Start the Smart Device Data Collector
You can use any of these devices to open the Smart Device Data Collector.

• iOS(iPhone/iPad)

• Blackberry

• Android Phone/Tablet

• PC/laptop

The web tool can be accessed remotely at this URL:

http://<server_name>/DataCollector

A link to the web tool is also provided in the programs folderStart > All Programs >
Schneider Electric:

The Smart Device Data Collector uses the same login credentials as PowerMonitoring
Expert - Data Center Edition. It can only be accessed by users with the Controller, Operator,
or Supervisor access level.

1. Go to the URL in a browser or use the shortcut in the programs folder. The sign in screen
appears.



2. Enter your login credentials. Themain screen appears.

Themain screen contains theSelect Group box (for generator groups) and theSelect
Equipment box for a device in the selected group.
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An error message appears if you do not have the correct access level or
you enter the wrong credentials.

The selection boxes are empty if the generators have not enabled the Smart Device Data
Collector option in the configuration tool.

To view the online help or sign out of the tool, click themenu button.

Log Generator Data
When you need to enter generator data into PowerMonitoring Expert - Data Center Edition,
you can use the Smart Device Data Collector to submit the data.



In the Generator Performance Configuration Tool, verify theData Collector option is
enabled for the generator you want to log data for. See "Assign Engine Data" on page 72
for instructions. The custom data values you create in the configuration tool will appear in
the web tool.

Follow these steps to log generator data:

1. In the first two boxes, select the group and specific generator you want to log data for.
The custom data value fields, such as Battery Volts, for the generator appear.

NOTE: The data value fields are the data values added in the configuration tool. For each
data value, there is a value entry box and a date box.
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2. For each data value, enter the new data in the box.

• Click Set to set the timestamp for the new data.

• If you want to edit the timestamp value, click Edit and enter the value. All date fields in
use theMM/DD/YYYY format.

3. Click Submit to log the new data.

When the data has been successfully logged, the field borders turn green and a green
check mark appears. The submitted timestamp is in server time. In PowerMonitoring
Expert - Data Center Edition, the data is logged in UTC.



An error message appears if a field is blank or has data with invalid format, as shown in
these examples. Data with the incorrect format or blanks do not get stored in Power
Monitoring Expert - Data Center Edition.

4. To edit the data after you click Submit, click Edit and the fields become editable again.

5. Click Clear if you want to clear all the fields.

You can select other groups and devices to submit additional data.
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